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Introduction 

About the SPS-300 PC Utility 

The SPS-300 PC Utility provides basic PC communication functions for Samsung SPS-300 

Series ECRs:  SPS-320, SPS-340, and SPS-345.  This utility was designed primarily as a 

dealer tool - to save, edit, and download programs.   

 

Note:  The SPS-300 PC Utility supports direct onsite serial connection to the ECR or 

Modem communications via a phone line.   

SPS-300 Series PC Utility Features  

 Support Multiple Stores 

 Save and Load ECR programs 

 Edit ECR programs 

 Convert and Download Logo bitmap images for the receipt 

 Modem connection over a wired phone line 

Note:  The SPS-300 Series PC Utility was developed to work best with a screen 

resolution of at least 1024 x 768 pixels.   
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Getting Started 

Setting the SPS-300 RS-232C Port 

At the SPS-300 Series ECR, you must select ‘PC’ as the device that is attached to one of the 

available RS-232C communications ports. 

1. At the S control lock position menu, press 8 for RS232C programming.  The port 

selection screen displays: 

           RS232 PORT  

 

1. RS232 PORT 1 

2. RS232 PORT 2 

3. RS232 PORT 3 

4. RS232 PORT 4 

 

 

2. Enter the digit (1-4) corresponding to the port you wish to program.  The 

appropriate PORT PROGRAM screen displays: 

       PORT 1 PROGRAM PG1 

BAUD RATE                    0 

 0:9600   1:1200   2:2400   

 3:4800   4:19200  5:38400 

 6:57600  7:115200  

PARITY CHECK                 0 

0:NONE   1:ODD   2:EVEN 

DATA BITS(0:8 1:7)           0 
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3. Set the BAUD RATE to match the setting used in the SPS-300 PC Utility, set 

PARITY CHECK setting to “0” for NONE and DATA BITS setting to “0” for 

8 data bits.   

4. Press PAGE DOWN to view page 2 of the RS232C port program:   

       PORT 1 PROGRAM PG2 

STOP BITS(0:1 1:2)           0 

DEVICE FUNCTION              1 

------------------------------- 

0:NONE    1:PC      2:SCL 

3:RJ      4:RP      5:LIQUOR 

6:SCAN    7:COIN    8:RESERVED 

9:POLE   10:EFT    11:PDC 

5. Set the STOP BITS setting to “0” for 1 stop bit.  

6. Press ENTER to select the DEVICE FUNCTION field.  Press “1” to select PC 

as the device function and press the CLEAR key to exit and save changes.   
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Note that the current store 

information shows on the bottom 

line on the main screen 

 

Installing the Utility 

The SPS-300 PC Utility can be downloaded from the SPS-300 Series page in the Dealer Area 

on the CRS Web Sote at: http://crs-usa.com/DEALER/deal300.asp 

1. Download and extract the SPS-300 PC Utility to a folder on your hard drive.  

2. From Windows Explorer, locate the file: setup300.exe.  Double click the file to open 

the installation dialog box.   

3. Follow the instructions to complete the installation.    

Starting the PC Utility 

1. Choose Start, Programs, SHC PC Utility and then 300PC.  The Store Setting 

dialog box displays.   

(If you are starting the utility for the first time, you will be prompted to first add a 

store.  Enter the Store Name and press OK.) 

2. Select the store you wish to open from the Store Settings drop-down list box and 

click the Close button.  The SPS-300 PC Utility main screen is displayed.   

 
 

 

 

  

http://crs-usa.com/DEALER/deal300.asp
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Store Settings 

There is no limit to the number of stores you can save with the SPS-300 PC Utility.  If you 

are starting the utility for the first time, you will be prompted to first add a store.  Enter the 

Store Name and press OK; The STORE SETTING Dialog Box displays. 

 

 

If you have more than one store saved, select the store you wish to open from the Store 

Setting drop-down list box. 

Key Type 

You must select the correct keyboard that corresponds with the register you are using:   

 Note: The 63-key keyboard is not used.   

 Select the 150-key flat keyboard for the ER-920 or ER-940. 

 Select the appropriate 98-key keyboard for the ER-925 or ER-945.  

98-Key     98-Key (Double) 

 

 

 

 

Use 98-Key for the expanded Raised Keyboard 

Use 98-Key (Double) to the default double-wide 21 PLU raised keyboard.  
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Baud Rate 

Set the baud rate for communication to the ECR, this setting must match the baud rate stting 

as set on the ECR RS-232 port setting.  

PORT# 

This is the PC COM Port you are using to connect to the ECR. 

Use Modem 

Only check this option if you are connecting to a telephone modem to remotely connect to the 

store via modem connection. Special modems settings need to be configured on both the store 

and remote location modems.  

Phone 

This is only used with modem connections; enter the phone number for the stores modem on 

site that is connected to the ECR. 

IRC Setting 

Check all registers that are connected in the register’s IRC network. If using a single 

standalone register, only register 1 would be checked. 

 

Selecting a Store 

 Select the working store you wish to open from the Store Setting drop-down list box 

when you start the utility.   

 To change the working store after the utility has been started, choose Setup Store 

from the Setup menu and select a different store from the drop-down list box.   

Adding a Store 

 Choose Add Store from the Setup menu.  At the Add Store dialog, enter the store 

name and click OK.  At the Store Setting dialog, select the model, PC port, baud 

rate and IRC setting then click the CLOSE button.    

Removing a Store 

 Choose Remove Store from the Setup menu.  At the Remove Store dialog, select 

the store name to remove and click OK to remove the store, select Cancel to close 

the windows without removing the store.
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Upload/Download Programs 

UpProgram 

Upload a program before beginning program edit functions.   

 Select the specific program segment you wish to upload from the 

UpProgram (ECR->PC) menu, or select All Program to upload the 

entire register program. 
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DownProgram 

The Memory Allocation on the ECR must be set to properly to accept the store 

program file being downloaded.  You must enter the memory allocation manually 

at the register before downloading.  We cannot download memory allocation 

from the utility. 

Downloading a program from the SPS-300 PC Utility will overwrite the existing 

register program.  

 

 Select the program segment you wish to download from the 

DownProgram menu, or select All Program to download the entire 

register program (not including PreAmble and PostAmble images, that 

are downloaded separately.)   
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Edit Programs 

Procedures 

With the exception of memory allocation, all register programs can be edited 

with the SPS-300 PC Utility.  You will find options neatly organized on dialog 

boxes, making option programming on the PC Utility more efficient than 

programming options at the register.   

 You must upload a program before program edit functions are allowed.   

1. To edit a program, choose the appropriate program from the EditProgram 

menu.  An example of each program dialog box is shown in this chapter.   

2. After edits, click Save to exit and save changes, or click Cancel to exit 

without saving changes.   

Tips 

 Each individual Store’s data is located in a separate folder within the main 

SPS-300PC folder on your local drive.   

 If you are building a new register program based upon an existing store, you 

can copy an existing store’s program files to a new store folder.  It is often 

more efficient to modify an existing program than to start over with a new 

one.   

 If you are building a large PLU file with identical (or similar) options for 

each PLU, you may find the from/to PLU programming at the register useful.  

For example, you can first program the identical options for a range of PLU’s 

at the register.  Then upload the PLU program with the utility.  Use the utility 

to program descriptors, prices and make adjustments to each PLU 

individually.  Finally, you can download the completed program to the 

register.   

 If you have questions regarding the meaning of ECR features and options, 

refer the SPS-300 Operator’s and Programming manual for an explanation 

of your program options.   
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Program Edit Screens 

From the EditProgram menu, select a specific program area to edit that part of an 

existing SAM4s SPS-300 series ECR program.  Remember that the program 

options in this program allow you to edit the same program options that you set 

on the Sam4s SPS-300 series ECR through the register's keyboard.   

Definitions for the specific options on the various programming screens are best 

answered by referring to the SAM4s SPS-300 Operator’s and Program Manual. 

 

Note:  When editing descriptor fields, you can make bold characters print on the ECR 

by entering a tilde () before each character that you wish to be bold.  Each bold 

character occupies two character positions.   
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PLU 

The PLU file is maintained here.  Refer to the SAM4s SPS-300 Operator’s and 

Program for a complete description of the PLU program options.   

 

Simply click on the PLU you wish to edit from the list of PLU’s and edit the 

Descriptor, Group assiginment, Price, and other options as needed. Click on 

SAVE when you have finised editing. 

 

You can also click in the PLU CODE box and enter the number of the number of 

the PLU you wish to edit then press the enter key on your keyboard. That PLU 

will display, edit the PLU as needed, click SAVE when you have finised editing. 

 

If you are entering in scanned items into the database, click in the PLU CODE 

box and scan the product you want to add to the PLU database. Edit the PLU as 

needed, click SAVE when you have finised editing. 

When all items have been added and edited as needed, press EXIT to return to 

the main menue screen. 
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Groups 

Group descriptor and options for each group are progrmmed here.  (The number 

of groups is determined in the register's memory allocation, you can allocate up 

to a maximum of 99 groups.)   

Select a group from the list to edit the options as needed for that group; refer to 

the SAM4s SPS-300 Operator’s and Programming Manual for a complete 

description of your program options.   

Click the SAVE button when you have finished editing your groups to return to 

the main menue screen. 

 

Tax 

Each of the 4 possible taxes can be set for an add-on percentage, tax table or 

VAT.  Tax 4 has the additional option to be set as GST Ttaxable as well. Follow 

the instructions on the screen, or refer to the SAM4s SPS-300 Operator’s and 

Programming Manual for a complete description of your program options.   
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System Option 

Each system option can be enabled or disabled; check the options you want to 

enable or uncheck to disable the option. Refer to the SAM4s SPS-300 Operator’s 

and Programming Manual for a complete description of your program options.   

 

Print Option 

Each print option can be edited.  Check the option to enable that option or 

uncheck to disable the option. Refer to the SAM4s SPS-300 Operator’s and 

Programming for a complete description of your program options.   
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Function Key 

You can program the different options for each function key.  Follow the 

instructions on the screen, or refer to the SAM4s SPS-300 Operator’s and 

Programming Manual for a complete description of your program options.   

   

Clerk  

Clerk descriptor (name) and options are set here.  The total number of clerks is 

determined by the memory allocation set in the ECR. You can allocate memory 

for a maximum of 99 Clerks.  

Follow the instructions on the screen, or refer to the SAM4s SPS-300 Operator’s 

and Programming Manual for a complete description of your program options. 
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Logo/Descriptors 

You can program a custom preamble, postamble messages to print on customer 

receipts. You can also program the check endorsement message and DataTran 

message.   

Unique descriptors for certain financial and clerk report totals can be 

programmed here as well.   
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PLU Stock 

Upload stock from the ECR first.  All PLU’s flagged as an Inventory Item will 

populate this screen.  For stock items, edit quantities as needed, and then 

download to the ECR.   

1. Choose Stock from the EditProgram menu.  The PLU Stock dialog box 

displays with a list of all PLU’s flagged as an Inventory Item and their 

current stock quantities. 

2. You can edit quantites here; two decimal places is assumed on quantities. (To 

enter a quantity of 100 you need to enter 10000 or enter quantity with the 

decimal 100.00). 

3. Press SAVE after entering your quantity. Continue editing as necessary. 

4. When editing is complete, click EXIT to return to the main screen.  

These Stock quantities can then be sent to the register from DownProgram (PC-

>ECR) menu. Depending on the system option setting for Inventory Count 

Program, the quantities will either add to the current stock or replace the current 

stock quantities. 
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NLU 

NLUs are keys on the keyboard (like traditional department keys) used to access 

specific PLU’s.  NLU#1 through NLU#300 are available for assignment to the 

keyboard.  

On the default keyboard on the SPS-325/345 ECR’s (raised keyboard) have 21 

NLU keys and can be expanded to 63 NLUs.  The SPS-320/SPS-340 ECR’s (flat 

keyboard) have 100 NLUs on the default keyboard.   

Each NLU key is assigned the same corresponding PLU number, i.e. NLU key 

number one is assigned PLU #1.   

However, with this program you can assign any PLU number you wish to any 

one of the NLU keys.  PLU’s must be programmed into the database before you 

are able to assign the PLU to the NLU key. 

 

1. Use the scroll box at the right of the screen to view all of the NLUs. 

2. Click on the NLU you wish to edit, the PLU list displays.  

3. Scroll through the PLU list and click on the PLU you want to assign to the 

selected NLU key or press CANCEL to not change the current PLU/NLU 

assignment. 

4. Click SAVE to save changes and return to the main menu.    
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PLU LookUp 

Each of the PLU LOOK UP keys can be programmed here to list specific PLU’s 

 
 

 

 

 

 

 

 

To add item to a PLU LookUp:  

Left-click on the line you wish to add 

an item to, then select the PLU you 

want to add to the Look Up 

To delete item from a PLU LookUp:  

Right click on the line you wish to delete. 

Select Yes.  The item is deleted.   
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Macro 

The Macro programming screen allows easy programming of Macros using the 

keyboard layout display.  

Simply select the Macro number from the top row of the screen and press the 

keystrokes for the Macro from the display. As shown in the example below; 

Macro 2 was setup for a $20 speed Tender key by pressing 2 0 00 CASH. 

 

If you make a mistake during Macro programming you can clear an entry by 

pressing the CLEAR CURR button or press the CLEAR ALL to clear all 

keystrokes and begin anew.  

When you have completed the programming for your Macro’s press the  

icon to save your edits.  

Press EXIT to return to the main screen of the SPS-300 PC Utility. 
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Key Layout 

The Keyboard Layout screen allows you to edit the keys on the keyboard, change 

key assignment and design a key sheet to be printed for the register keyboard 

(Requires 11” x 13” paper). 

 

Note:  To see the entire keyboard on the screen, the screen resolution must 

be set to 1024 x 768 pixels.  Use scroll bars to view the entire keyboard.   

 

The screen shown is Expanded Raised keyboard 

Select a key on the layout screen to edit that key.  

       

Enter a new descriptor for the key, max is 10 characters per line.  
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You can also assign a different function key to the key location. 

Select the Key you wish to change by clicking on the desired key, then click on 

the KEY CODE button. 

    

Scroll through the list to the key you wish to assign; click on the key to make the 

new assignment. 

Select a key color if desired by clicking on the KEY COLOR button. 

   
 

  

Choose the key color you want from the color 

palette, then press OK.  
 

 

The key code list will appear as shown here. 

You can also create custom colors for 

your keyboard.  

 

Custom colors can be saved to allow use 

on other keys on the keyboard layout.  

 

Note: custom colors are saved only for 

the current keyboard layout editing 

session.  
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To select a different font, click on the SELECT FONT button.  

 

Press OK when you have finished editing. 

 

 

Save your changes by pressing the  icon; then exit by pressing the X. if you 

exit without saving you will get a prompt: 

 

Press Yes to save your keyboard edits.  
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Comm Port 

Set options for the communications when you are connecting optional hardware 

to the register.   

Follow the instructions on the screen, or refer to the SAM4s SPS-300 Operator’s 

and Programming Manual for a complete description of your program options.   

 

Mix & Match 

1. Choose Mix and Match from the EditProgram menu.  The appropriate Mix 

and Match dialog box displays:   

 

2. You can give the Mix & Match discount a specific name/descriptor.  Set the 

trip level to indicate how many items to ring before the discount is applied.  

Set the discount amount in the price field.  (As shown above, a $1 discount 

will apply after three items are registered.)   

3. Click OK when finished editing the Mix & Match discounts to save changes 

and return to the main menu.     
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Etc. – Tare/Age Verification/Drawer Limit/Change 
Limit/PC Schedule Time/Training Mode Password 

 

Tare Weight 

You can pre-program five tare weights, representing the weight of different 

containers.  When you place an item and a container on optional scale, you can 

enter the tare number to automatically subtract the pre-programmed tare weight.  

Age Verification  

Up to five different age categories can be created for age restricted items, for 

example tobacco products could be restricted at age 18 and alcohol products 

restricted at age 21.  The age entries are made with this program.  In addition, 

you will need to use the Group program to define the items that will be restricted.   

Drawer Limit 

You can set a cash-in-drawer limit.  When cash in drawer exceeds the limit a 

warning will display on the screen.   

Check Change Limit 

Use this program to set the maximum amount of cash that can be returned when a 

check is tendered for an amount greater than the amount of the sale. 

PC Schedule Time  

Set the Hour and Minute (HH:MM) as per 24 hour clock when you want the ECR 

to automatically go into Online Mode for PC communication.  
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Training Mode Password 

If you wish to use training mode, you must program a password that you will use 

to enter training mode. The password may be up to 4 digits long, however, if you 

choose to use a password less that for digits, you must enter preceding zeros to 

complete a 4 digit entry. For example, if you program the password to be "77", 

you must type "0077" when entering training. 

Level Activate Time 

Use this program to select the time for each price level to activate. Set the time in 

24-hour format (military time, i.e. 1300-1pm).  

Datatran No Sign 

No signature required if EFT transaction is under xxxx (i.e. if 2000 is set here, no 

signature is required on EFT transactions under $20.00.) 

KP Starting Number 

Set a KP Starting Number for the KP Order number if desired. Number can be 

upto 4 digits.  

 

Memory Allocation 

You can view but not edit memory allocation.    
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Reports 

Collecting Reports 

Reports cannot be polled with the SPS-300 Series PC Utility.  However they can be saved to an 

SD card.  SAM4s SPS-300 series reports are saved to the SD card in either .csv or .rpt format.  

When saved in .csv format, you can use a PC productivity program, such as Microsoft Excel ™ to 

open, view and manipulate the data.  If you save reports is .rpt format, using this utility you can 

view the report data, export it to Microsoft Excel, and/or export it to a text file. 

Saving Reports to an SD Card 

All reports saved in the same procedure.  Reports saved are the current X1 readings.   

1. At the ECR, turn the control lock to the S position. 

2. Choose “9” from the S Mode menu (Press PAGE DOWN to view the option).   

3. From the SD Card Operation menu choose “3 Report Backup”.   

4. From the “Report Format?”  Screen press “0” for .rep format or “1” for .csv format.  

The printer will print an “uploaded” message for each report successfully uploaded.   

Report File Conventions 

Saved reports are stored in a folder named with the current date, located in a folder under the 

store name.  For example:   

 .rep format files:  SD\SPS300\REPBACK\Storename\20111130  

.csv format files:  SD\SPS300\CSVBACK\Storename\20111130 

Where 20111130 is the date the reports were saved, November 30, 2011.   

Reports listed in this folder are named using the following convention: 

C L K 0 1 1 3 2 . r e p  

      Report type: Clerk (CLK), financial (FIN), PLU, group 

(GRP), Electronic Journal (EJ), Mix & Match (MNM), 

Stock (STK), Daily Sales (DAY), Open Check (TBL) 

      0=Daily X1; 1=Period-to date X2 

      Time in 24 hour format 
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View Reports 

1. Select the type of report you wish to view from the ViewReport menu. 

 

2. The File Associate dialog displays.  Click the Browse ( … )button to locate the report you 

wish to view.   

 

3. Select the report you wish to view.  Note that report you select must match the type of report 

you selected from the menu.  For example, if you selected PLU from the ViewReport menu, 

you must select a report file that begins with the text “PLU …”; if you selected FINANCIAL 

from the ViewReport menu, you must select a report file that begins with the text “FIN…” 

 

4. Click Open. The File associate dialog displays with your selected report path. 
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5.  Click OK to open the report 

 

6. Choose Setting to select zero skip options.  Click OK to close the dialog and return to the 

financial report window.   

 

7. From the report window, choose: 

 

Print:  to print the file at your printer 

Export to Excel: to save the report in text (.xls) format 

View on Excel: to open Excel and view the file 

Export to Text:  to save the report in Excel (.txt) format 

File Associate:  to select a new report 

Close:  to exit 
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Prepare & Load Bitmap Logos 

Load/Save Receipt Images 

You can load a preamble and postamble image for your receipt or soft guest check.  Before 

loading, the images must be converted by the PC Utility to .img format.  After conversion, they 

can be loaded directly by connecting a PC to the SPS-300 or by copying the images to a SD card 

and loading (or saving the image) using the SD utility program described here.   

The information presented here was derived from a version of MS Paint on Windows XP, your 

version of Paint may appear differently but the same principles explained here will still apply.  

 

Note that after loading the images, you must set Print Options on page 14 of the Print 

Options program to activate the image printing.   

Preparing a Graphic Logo Bitmap for an SPS-300 Series 

The image must be black/white, 384 x 192 pixels, and 10 Kbytes or less in size. 

1. Open MS Paint. 

2. Open the image file you wish to use.   

3. Choose Attributes from the Image menu.  The Attributes dialog box displays. 

 

4. The image dimensions must be no larger than 384 pixels wide by 192 pixels high.  If the 

image size in pixels is greater than the maximum, you must resize your image.   

a. Click OK to exit the Attributes dialog. 

b. Select your image.  (Choose Select All from the Edit menu.) 
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c. Using the handles of the selected image, resize the image.  Keep the image in the 

upper left corner of the screen.   

d. Choose Attributes from the Image menu.  The Attributes dialog box displays again.  

Enter 384 in the Width field; enter 192 in the Height field; select Pixels as the unit.  

Click OK to exit the dialog box.   

e. Your image will be cropped to the 384 x 192 pixel size.  If you cropped part of the 

image you wish to keep, you can undo (Ctrl + Z) and try again.  You may have to 

experiment a bit to resize the image inside the 384 x 192 pixel limit.   

5. After the image is sized, select Black and white in the Attributes dialog. 

6. Save your image as type “Monochrome Bitmap (*.bmp,*.dib)” and confirm that the size 

is 10k or less.  If you resized your original image, you may wish to rename when you 

save, so that you preserve a copy of the original image.   

Use the PC Utility to Convert the Image 

1. Install the SPS-300 PC Utility on your PC.   

2. At your PC, start the SPS300 PC Utility.  (Select Start, Programs, SHC PC 

UTILITY, SPS300 PC UTILITY.)  The Store Setting dialog box displays.   

3. If you are starting the SPS300 PC Utility for the first time, you must define a store 

name, or if a store is already defined, you can select the store from the drop down list.  

After the store is defined or selected, click Close.  The PC Utility program starts.   

4. Move the bitmap (.bmp) logos you wish to use into the store directory  

(i.e. C:\SPS-300PC\storename.) 

5. At the PC Utility, choose Convert Logo Image from the Utility menu.  The Bmp 

dialog box displays.   

6. Click FILE OPEN.  Select the bitmap image you wish to use from the Open dialog 

and click the Open command button.  

7. Click the SAVE AS PRE IMG or SAVE AS POST IMG button. 

 

8. When the image is selected, click OK.  Verify that the message “Save As 

UserPre.Img” or “Save As UserPost.Img” displays.  If the file is too large, and cannot 

be loaded, the message “File Size Error” displays.   
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Copy the Images to an SD Card 

The PC Utility will create two image files:  

 USERPRE.IMG 

 USERPOST.IMG 

They will be located in your PC at: 

 C:\SPS-300PC\Store Name 

Copy the mages to the following path on your SD card: 

 SD\\SPS300\PgmBack\Store Name 

Important:  In the path:  C:\SPS-300PC\Store Name, the store name is the name you have 

defined as the store in the PC Utility.  Note:  You must use the same store name in the SPS-

300 Series ECR at System Options page 18.  

Load the Images by SD Card 

1. Insert the SD card in the register’s SD slot.     

2. Turn the control lock to the S position. 

3. From the second page of the the Service Mode menu, select “9 SD Card Operation”.  

4. From the SD Card Operation menu select “4 PRE_IMAGE LOGO LOAD”.  

5. The message “PREAMBLE LOGO LOADED!” will print on the receipt printer. 

Saving Images from an SPS-300 to an SD Card 

1. Insert the SD card in the register’s SD slot.    

2. Turn the control lock to the S position. 

3. From the second page of the the Service Mode menu, select “9 SD Card Operation”.  

4. From the SD Card Operation menu select “5 PRE_IMAGE LOGO BACKUP”.  

5. The message “PREAMBLE LOGO BACKUP!” will print on the receipt printer. 
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Printing the Logo Image – SPS-300 Settings 

Four options on page 14 of Print Option Programming affect graphic logo printing.  Choose Y or 

N as appropriate to print the pre or post message on receipts and/or soft guest checks.   

 

       PRINT OPTION       PG 14 

PRINT PLU# ON RECEIPT         N 

PRE-PRN GRAPHIC LOGO          N  

POST-PRN GRAPHIC LOGO         N  

 ON RECEIPT  

PRE-PRN GRAPHIC LOGO          N  

POST-PRN GRAPHIC LOGO         N  

 ON GUEST CHECK 
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Import/Export PLU Files 

PLU PGM to Excel/PLU Excel to PGM Utilities 

This feature of the SAM4s SPS-300 PC Utility is found under the Utility tab.  Select “PLU PGM 

TO EXCEL” or “PLU EXCEL TO PGM”.   

 When the “PLU PGM TO EXCEL” utility is run, the Excel file is place into the folder:  

C:\SPS-300PC\Storename.  The file is named PLU.csv.   

 When the “PLU EXCEL TO PGM” utility is run, the PLU.csv file in the folder:  C:\SPS-

300PC\Storename will replace the PLU file and become the active PLU file for the store.  

PLU Key for CSV Import/Export 

 

 

 

Example of Exported CSV File (in Excel): 

PLU Scan 
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Excel PLU.csv Key 

Column on PLU.csv Corresponding Option 

A PLU CODE 

B DESCRIPTOR 

AJ PRICE/HALO 1 

AK PRICE/HALO 2 

AL PRICE/HALO 3 

AM PRICE/HALO 4 

AN PRICE/HALO 5 

F PRESET 

G PRESET OVERRIDE 

H TAXable By: 1 

I TAXable By: 2 

J TAXable By: 3 

K TAXable By: 4 

L FOOD STAMP ELIGIBLE 

M NEGATIVE ITEM 

N HASH 

O SINGLE ITEM 

P NON-ADD # COMP. 

Q GALLONAGE ITEM 

R INVENTORY ITEM 

S DISABLE 

T SCALEABLE 

U AUTO SCALE 

V CONDIMENT 

W COMP. CONDIMENT 

X PRINT ON RECEIPT 

Y PRINT ON DISPLAY 

Z PRINT ON CHECK 

AA PRINT PRICE ON RECEIPT 

AB PRINT PRICE ON CHECK 

AC DISABLE PROMO 

AD COUNTER NOT RESET 

AE PRESET OVERRIDE IN       
MANAGER CONTROL 

AF DISABLE VOID AND 
RETURN 

AG AUTO TARE 

C GROUP # 1 (1-20) 

D GROUP # 2 (1-20) 

E GROUP # 3 (1-20) 

AH MIX & MATCH # 

AI PLU LINK CODE 
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PLU Key Viewed on Utility PLU Program Window 

 

 

A 

B 

H 

E 

G 

J K 

L 

C 

I 

D 

F 

AG 

AH 

N 

P 

R 

Y X 

V 

T 

AC 

M 

O 

Q 

S 

U 

W 

AF AD 

AB 

Z 

AJ
G 

AE 

AK 

A
M 

AL 

AN 

AA 

AI 
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Import Note – Notation of Large PLU Numbers 

Using default Microsoft Excel settings, numbers exceeding 12 digits will display in scientific 

notation as shown in the sample sheet below: 

 

Caution:  If you are editing a PLU.csv file in Excel, and you are using large PLU numbers (such as 14-

digit UPC numbers), you must take care to change the formatting of the number in Excel, 

so that the correct PLU number is sent to the PLU file.   

To Change PLU Number Display in Excel 

1. On the Excel spreadsheet, select column “A” (the PLU number column). 

2. Choose Cells from the Format menu.  The Format Cells dialog box displays with the 

Number tab selected.  Note the the Category selected is “General”.   
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3. Select the ‘Number” category and set the Decimal places field to “0”.   

 

4. Click OK to save the settings.  Note the large number now displays completely, without 

scientific notation.   
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Appendix 

Cabling Diagrams 
You can configure cables yourself with the diagram provided here, or you can order the 

appropriate cables from CRS Parts at 1-800-333-4949.   

Direct Connection 
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Manual Revision Record 

Edition Date published Revision contents 

Preliminary   

V1.0 4/27/2012 Keyboard Layout Note added 

V1.1 4/18/2013 Added new keyboard selections available at utility 

version 01.019 

V1.2 12/16/2015 PLU LookUp added to Edit Program menu 

V1.3 12/8/2016 Updated Screens, added programming information  

   

   

   

   

   

 

 


